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Project Defect Report 

 

 
Bug Ubuntu0000014 – Grub can’t be installed to other partition Section No.1  

Project  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  Dell 
D600 

OS  Ubuntu Component  2.Function －

2.1Installation 
Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Grub can’t be installed to other partition Section No.1 

Description  

1.Insert Ubuntu installation CD, and boot system from CD; 
2.Run the installation steps correctly; 
3.Select “No” for question “Install grub boot loader to MBR or not”; 
4.Specify the location to be Sector 000 of one partition(eg. Hd0,6); 
5.Intall grub, and restart system after the installation is completed; 
6.Grub is installed into MBR. 

 
Bug Ubuntu0000016 – Lilo can’t be installed 

Project  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  Dell 
D600 

OS  Ubuntu Component  2.Function －

2.1Installation 
Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Lilo can’t be installed 

Description  

1.Insert Ubuntu installation CD, and boot system from CD; 
2.Run the installation steps correctly; 
3.Skip grub and choose lilo as load program; 
4.Whatever location you specified for lilo, lilo installation is failed with “Error Code 1”. 
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Bug Ubuntu0000018 – Review Partition table lead to password and install fail 

Project  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM 9CC 

OS  Ubuntu Component  2.Function －

2.1Installation 
Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Review partition table lead to password and install fail 

Description  

1.Run install; 
2.Partition the system correctly; 
3.Format partition and setup the base system; 
4.Return to view the partition table before set user and password; 
5.Be sure no change is done for partition table and go back to user setting page; 
6.System report installation can’t be continued successfully. 
 
Bug Ubuntu0000019 – Choosing ubuntu-image-386 as kernel allowing user to set root password 
during installation 
Project  Ubuntu Linux 

OS Testing 
Version  5.04 Platform  IBM 9CC 

OS  Ubuntu Component  2.Function －

2.1Installation 
Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Choosing ubuntu-image-386 as kernel allowing user to set root password 
during installation 

Description  

1.Run install; 
2.Partition the system correctly; 
3.Format partition and setup the base system; 
4.Return to review the partition table before set user and password; 
5.Be sure no change is done for partition table and go back to user setting page; 
6.After system report installation can’t be continued successfully, rerun step 2-5 more times; 
7.Rerun installation from partition; 
8.Choose ubuntu-image-386 as kernel; 
9.At user setting phase, system will give the root password setting interface.  
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Bug Ubuntu0000020 – Resetting root password only allow to retype the confirm password 

Project  Ubuntu 
Linux OS 
Testing 

Version  5.04 Platform  IBM 9CC 

OS  Ubuntu Component  2.Function －

2.1Installation 
Priority  P3  

Reproducibility Hard Submit  qinxie Reviewer caozhy  

Summary  Resetting root password only allow to retype the confirm password 

Description  

1.Run install; 
2.Partition the system correctly; 
3.Return to review the partition table before set user and password; 
4.Be sure no change is done for partition table and go back to user setting page; 
5.After system report user setting fail, rerun step 2-5 more times(about 3-5); 
6.Go back to partition and begin reinstall from this step; 
7.Choose ubuntu-image-386 as kernel; 
8.In the user setting page, root password setting is enable and input different original password 
and confirm password; 
9.System report root password mismatch, and ask to reset password; 
10.In reset page, only confirm password can be retype. 

 
Bug Ubuntu0000010 - In login screen setup ,the "test sound" button is invalid. 

Project Name  Ubuntu Linux OS 
Testing  

Version   5.04 Platform   HP EVO 
D321  

OS  Ubuntu  Component   2.Function －
2.3Control 
Panel  

Priority   P3  

Reproducibility   Reproducible   Submit   jianggw  Reviewer   caozhy 

Summary  In login screen setup ,the "test sound" button is invalid. 

Description   

1. select system/administration/login screen setup/accessibility 
2. choose a sound file 
3. click the "test sound" button, no sound could be heard. 
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Bug Ubuntu0000009 - Add/Remove programs doesn't run well. 

Project Name  Ubuntu Linux OS 
Testing  

Version   5.04 Platform   HP EVO 
D321  

OS  Ubuntu  Component   2.Function －
2.3Control 
Panel  

Priority   P3  

Reproducibility   Reproducible   Submit   jianggw Reviewer   caozhy 

Summary  Add/Remove programs doesn't run well. 

Description   

1. select applications/system tools/ add/remove programs  
2. it couldn't display the software list which is installed,so we can't add or remove any software. 

 
Bug Ubuntu0000011 - Generating random password is useless. 

Project Name  Ubuntu Linux OS 
Testing  

Version  5.04 Platform   Dell 600 

OS  Ubuntu  Component   2.Function －
2.3Control 
Panel  

Priority   P3  

Reproducibility   Reproducible   Submit   heqq Reviewer   caozhy 

Summary  Generating random password is useless. 

Description   

1.System->Administration->Users and Groups->Add User.->Basic Setting->Contact 
Information->Password->Set password by hand->OK. 
2.Select this user->Properties->Password->Generate random password->record the 
password->OK. 
3.Restart the computer. Log in with the new user name and the random password .The system 
will prompt you that incorrect user name or password. Log in with the new user name and the 
hand-in password. You can log in the system. 
4.The Generating random password is useless. 
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Bug Ubuntu0000038 - Above two printers, the default printer is not to demonstrate the default 
icon. 
Project Name  Ubuntu Linux OS 

Testing  
Version   5.04 Platform   Dell 600 

OS  Ubuntu  Component   2.Function －
2.3Control 
Panel  

Priority   P4 

Reproducibility   Reproducible   Submit   heqq Reviewer   caozhy 

Summary  Above two printers, the default printer is not to demonstrate the default 
icon. 

Description   

1.System->Administrator->Printing->Printer->Add Printer. The system will automatically 
designate the first printer as the default printer, and give a default icon on its icon. 
2. Add another same name printer, and designate this printer as the default printer. 
But there is not a default icon on its icon. 

 
Bug Ubuntu0000052 - It is useless to amend the description in the printer's properties. 

Project Name  Ubuntu Linux OS 
Testing  

Version   5.04 Platform   Dell 600 

OS  Ubuntu  Component   2.Function －
2.3Control 
Panel  

Priority   P4  

Reproducibility   Reproducible   Submit   heqq Reviewer   caozhy 

Summary  It is useless to amend the description in the printer's properties. 

Description   

1.Systerm->Administrator->Printing->Click the printer icon with the right 
key->Properties->Description .Amend the description content, and close. 
2.Open the printer's properties again. The revision description information has not been 
preserved, and it is still primitive description information. 
 
Bug Ubuntu0000001 - It is unable to fast open the file which has opened with the vi editor 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.4Main Interface 
Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to fast open the file which has opened with the vi editor  

Description  

It is unable to fast open the file which has opened with the vi editor  
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Bug Ubuntu0000024 - It is unable to refresh the desktop. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.4Main Interface 
Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to refresh the desktop. 

Description  

It is unable to refresh the desktop. 

 
Bug Ubuntu0000049 - There is not the configure display properties in the desktop properties. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.4Main Interface 
Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  There is not the configure display properties in the desktop properties. 

Description  

There is the change desktop background on the menu through clicking the right-key on the 
mouse, but there is not the configure display properties. 
 
Bug Ubuntu0000002 - It is unable to open the system monitor in the taskbar 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM 6824 

OS  Ubuntu Component  2.Function －

2.4Main Interface 
Priority  P3  

Reproducibility  Reproducible Submit  yanqw  Reviewer caozhy  

Summary  It is unable to open the system monitor in the taskbar 

Description  

The right key single-clicks the taskbar, but there is not the system monitor option. 
You can open the system monitor by tow ways: 
1.Applications->System Tolls->System Monitor 
2.Add the system monitor to the taskbar 
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Bug Ubuntu0000053 - There is no system monitor in the taskbar defaultly 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM 6824 

OS  Ubuntu Component  2.Function －

2.4Main Interface 
Priority  P5 

Reproducibility  Reproducible Submit  yanqw  Reviewer caozhy  

Summary  There is no system monitor in the taskbar by default 

Description  

1.When the right key clicks the taskbar,the menu has no option of the system monitor. 
2.Can add the system monitor on the taskbar. 
3.Can also open the system monitor by the application of the system tools. 

 
Bug Ubuntu0000054 - "Always open in browser windows" setting don't work 

Project Name Ubuntu Linux 
OS Testing 

Version 5.04 Platform IBM 9CC 

OS Ubuntu Component 2.Function －

2.5File Browser 
Priority P3 

Reproducibility Reproducible Submit qinxie Reviewer caozhy 

Summary "Always open in browser windows" setting don't work 

Description 

1.Login; 
2.Open "File Browser"; 
3.Go to "Edit"->"Preference"->"Behavior"; 
4.Select "Always open in browser windows"; 
5.Close "Preference" setting; 
6.Active one text file, this file is opened by gedit, but not the browser; 
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Bug Ubuntu0000055 - the set "double click to activate items" makes clicking executable text file 
invalid. 
Project Name  Ubuntu Linux OS 

Testing  
Version   5.04 Platform   IBM 

9CC 
OS  Ubuntu  Component   2.Function －

2.5File 
Browser 

Priority   P3  

Reproducibility   Reproducible   Submit   qinxie Reviewer   caozhy 

Summary  the set "double click to activate items" makes clicking executable text file 
invalid. 

Description   

1.login 
2. open file management 
3. select edit/preferences/behavior 
4. set "double click to activate items" 
5. close preferences 
6. click any executable text file, there isn't any response. 
 
Bug Ubuntu0000004 - It is unable to open the shared graph file. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.6Network 
neighborhood 

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to open the shared graph file. 

Description  

When the Ubuntu user registers other computer which are loaded with the Windows 2000, 
Windows XP and Windows 2003 system, it is unable to open the shared file which has  suffix 
like *.gif,*.jpg,*.bmp and so on. 
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Bug Ubuntu0000005 - It is unable to automatically check the IP conflict and the DNS 
availability.  
Project Name  Ubuntu Linux 

OS Testing 
Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.6Network 
neighborhood 

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to automatically check the IP conflict and the DNS availability.  

Description  

1.Systerm->Administration->Networking 
2. You can set the IP through double-clicking the Ethernet connection. When the IP address is the 
same as other host computer's IP, the system will not prompt the IP address conflict. 
3. You can add new DNS Server, but the system will not prompt the DNS availability. Magically, 
some invalid DNS servers still can analyze the website. 

 
Bug Ubuntu0000008 - It is unable to set the password for the shared folder. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.6Network 
neighborhood 

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to set the password for the shared folder 

Description  

It is unable to set the password for the shared folder. 
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Bug Ubuntu0000042 - Windows2000/XP/2003 system is unable to visit Ubuntu system. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.6Network 
neighborhood 

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  Windows2000/XP/2003 system is unable to visit Ubuntu system. 

Description  

1.Open the Windows2000/Xp/2003's network neighborhood, and the computers on the network 
will show in the network neighborhood .If you visit the computer with Ubuntu system, you will 
be prompted to enter the hostname and password. But when you have entered the hostname and 
password, you still can not visit the computer with Ubuntu system. 
2.On the Windows system, Start->Run Application. Enter "\\other computer's IP address or 
hostname”. you will be prompted to enter the hostname and password. But when you have 
entered the hostname and password, you still can not visit the computer with Ubuntu system. 
3.You can not visit the computer with the Ubuntu system, so you can not visit copy and plaster 
the shared files and folders on those computers. 
 
Bug Ubuntu0000045 - It is unable to visit the Windows 2003 shared equipments. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.6Network 
neighborhood 

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to visit the Windows 2003 shared equipments. 

Description  

It is unable to visit the Windows 2003 shared equipments. 

 
Bug Ubuntu0000046 - It is unable to visit the Ubuntu shared equipments. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.6Network 
neighborhood 

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to visit the Ubuntu shared equipments. 

Description  

It is unable to visit the Ubuntu shared printer. 
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Bug Ubuntu0000047 - Ubuntu does not have the searching computer function. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.6Network 
neighborhood 

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  Ubuntu does not have the searching computer function. 

Description  

Ubuntu does not have the searching computer function. 

 
Bug Ubuntu0000021 - Command "file" can't recognize Chinese bracket 

Project  Ubuntu Linux OS 
Testing 

Version  5.04 Platform  IBM 9CC 

OS  Ubuntu Component  2.Function －

2.7Common 
Command 

Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Command "file" can't recognize Chinese bracket 

Description  

1.Open terminal; 
2.Run command "file" with parameter which includes Chinese Bracket (eg: file /root/boot/
（Copy）test.txt); 
3.File type can't be recognize the file type because of the Chinese Bracket.  

 
Bug Ubuntu0000025 - Command "cat" can't work with PPT or DOC files 

Project  Ubuntu Linux OS 
Testing 

Version  5.04 Platform  IBM 9CC 

OS  Ubuntu Component  2.Function －

2.7Common 
Command 

Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Command "cat" can't work with PPT or DOC files 

Description  

1.Open terminal; 
2.Run cat with PPT or DOC file(eg: cat officefile.doc); 
3.The displayed chars are abnormal.  
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Bug Ubuntu0000026 - Command "more" can't work with PPT or DOC files 

Project  Ubuntu Linux OS 
Testing 

Version  5.04 Platform  IBM 9CC 

OS  Ubuntu Component  2.Function －

2.7Common 
Command 

Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Command "more" can't work with PPT or DOC files 

Description  

1.Open terminal; 
2.Run cat with PPT or DOC file(eg: more officefile.doc); 
3.The displayed chars are abnormal. 

 
Bug Ubuntu0000034 - Command "less" can't work with refresh option 

Project  Ubuntu Linux OS 
Testing 

Version  5.04 Platform  IBM 9CC 

OS  Ubuntu Component  2.Function －

2.7Common 
Command 

Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Command "less" can't work with refresh option 

Description  

1.Create nonempty text.txt with gedit; 
2.Open one terminal and run "less text.txt"; 
3.Modify text.txt in gedit, input some character in first line:"hello world"; 
4.Use the refreshing parameter "Ctrl-R" in terminal which is running "less text.txt" 
5."hello world" isn't be displayed in the terminal which is running "less text.txt"  
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Bug Ubuntu0000013 - The fast forward function in CD Player has defect 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P3  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  The fast forward function in CD Player has defect 

Description  

1.Insert music CD into CD driver; 
2.Launch Application->Sound & Video->CD Player; 
3.Playing CD; 
4.Press Fast Forward button many times, the player actually execute rewind operation. 
Furthermore. Current Playing Time/Whole Time is displayed incorrectly in the GUI if press Fast 
Forward button frequently. 

 
Bug Ubuntu0000015 - Recording level monitor has refresh defect 

Project Name  Ubuntu 
Linux OS 
Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P3  

Reproducibility  Random  Submit  louli  Reviewer  caozhy  

Summary  Recording level monitor has refresh defect 

Description  

1.Launch Application->Sound & Video->Sound Recorder; 
2.Start recording; 
3.Launch Application->Sound & Video->Recording level monitor, then recording level monitor 
window is opened; 
4.Minimize recording level monitor window; 
5.Unminimize recording level monitor window, then the progress bar in the window is not 
display. 
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Bug Ubuntu0000017 - Sound Recorder has no response to all the operations when Recording  
level monitor is opened 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform HP-D330  

OS  Linux  Component 2.Function －

2.8Application  
Priority  P2  

Reproducibility Random  Submit  louli  Reviewer caozhy  

Summary  Sound Recorder has no response to all the operations when Recording level 
Monitor is opened 

Description  

1.Launch Application->Sound & Video->Recording level monitor; 
2.Launch Application->Sound & Video->Sound Recorder; 
3.Execute recording, then Sound Recorder has no response to all the operations. 

 

Bug Ubuntu0000022 - Sound Recorder has no response to all the operations when recording in 
the new window 

Project Name  Ubuntu 
Linux OS 
Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P3  

Reproducibility  Random  Submit  louli  Reviewer  caozhy  

Summary  Sound Recorder has no response to all the operations when recording in the 
new window 

Description  

1.Launch Application->Sound & Video->Sound Recorder; 
2.Press Record button, start recording; 
3.After several seconds, stop recording; 
4.Press New button，launch new Recorder window; 
5.In new Recorder window，press Record button, then Sound Recorder has no response to all the 
operations. 
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Bug Ubuntu0000023 - File Length is displayed incorrectly when playing record file 

Project Name  Ubuntu Linux OS 
Testing  

Version  5.04Platform HP-D330  

OS 
 

Linux  Component 2.Function －

2.8Application  
Priority  P3  

Reproducibility Random  Submit  louli  Reviewer caozhy  

Summary  File Length is displayed incorrectly when playing record file 

Description  

1.Launch Application->Sound & Video->Sound Recorder; 
2.Open a record file; 
3.Press Play button; 
4.File Length is displayed incorrectly. 

 

Bug Ubuntu0000028 - In Music Player, the result of import audio CD does not reflect to music  
library list 

Project Name  Ubuntu Linux OS 
Testing  

Version  5.04Platform HP-D330  

OS  Linux  Component 2.Function －

2.8Application  
Priority  P3  

Reproducibility Reproducible  Submit  louli  Reviewercaozhy  

Summary  In Music Player, the result of import audio CD does not reflect to music library 
list 

Description  

1.Insert music CD into CD driver; 
2.Launch Application->Sound & Video->Music Player; 
3.Select menu：Music->Import Audio CD, then Sound Juice launched; 
4.Sound Juice lists the content of Music CD. Press Extract button, then Sound Juice starts 
extracting CD; 
5.When extraction is completed，return to Music Player, the tracks that extracted recently are not 
in the music library list. 
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Bug Ubuntu0000029 - No prompt "overwrite" when add homonymous files to archive file. 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P3  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  No prompt "overwrite" when add homonymous files to archive file. 

Description  

1.Launch Application->Accessories->Archive manager; 
2.Open an archive file; 
3.Press add button, add files dialog pops up; 
4.Select a file, the file name is the same as the file in archive file, click the "add" button; 
5.The program doesn't warn us that "the homonymous file has existed" and overwrite it directly. 
 
Bug Ubuntu0000030 - Text editor has quit unexpectedly when press Cut button in print preview 
window 
Project Name Ubuntu Linux 

OS Testing  
Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P2  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary Text editor has quit unexpectedly when press Cut button in print preview 
window 

Description  

1.Launch Application->Accessories->Text Editor; 
2.Select menu File->Print preview，then print preview window is opened; 
3.Press Edit button in the toolbar of print preview window，then Cut button in toolbar is enable; 
4.Press Cut button，application has quit unexpectedly. 
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Bug Ubuntu0000032 - gThumb Image Viewer couldn't refresh timely after a picture has been 
rotated 
Project Name  Ubuntu Linux 

OS Testing  
Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P4  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  gThumb Image Viewer couldn't refresh timely after a picture has been 
rotated  

Description  

1.Launch Applications->Graphics->gThumb Image Viewer; 
2.View a picture formatted png or jpg in image mode; 
3.Select menu: tools->rotate images; 
4.Choose an arbitrary rotate mode, press the apply button; 
5.Return to the main interface, the image doesn't rotate yet; 
6.Press "Previous" or "Next" button in toolbar, then return to the original image, we may see the 
rotated result. 
 
Bug Ubuntu0000043 - Something is wrong with the exchange module in Evolution Mail 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P3  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  Something is wrong with the exchange module in Evolution Mail 

Description  

1.Launch Application->internet->Evolution Mail; 
2.Press the Exchange button in the left tool bar, switch to the Exchange window, but nothing is 
in it. 
3.Select actions->change exchanges password, a message box pop up to warn that the 
application has quit unexpectedly. 
4.Close the message box, Evolution doesn't quit unexpectedly and still could be used . 
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Bug Ubuntu0000048 – In OpenOffice.org Drawing, right button menu couldn't activated dialog 
box 
Project Name  Ubuntu Linux 

OS Testing  
Version  5.04 Platform  HP-D330  

OS  Linux  Component  2.Function －

2.8Application  
Priority  P4  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  In OpenOffice.org Drawing, right button menu couldn't activated dialog box 

Description  

1.Launch Application->Office-> OpenOffice.org Drawing; 
2.Select menu: View->Full Screen, go into full screen status; 
3.Select a menu which could pop up setting dialog from right button menu; 
4.No setting dialog is poped up, GUI is locked. No response when click the GUI. We only can 
exit it with "ESC". 
 
Bug Ubuntu0000003 - It is unable to open the website address and FTP address in the email 
attachment. 
Project Name  Ubuntu Linux 

OS Testing 
Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.9Application 
Software 
Integration  

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to open the website address and FTP address in the email 
attachment. 

Description  

When in the receive mail attachment includes the website and the FTP address connection, you 
can not open them through single-clicking the address connection in the attachment. If you do 
so, A window will spring the choice to open the website and FTP address. If you open the 
website address through the firefox website browser, the new window will spring the choice to 
open the website and FTP address. 
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Bug Ubuntu0000035 - It is unable to print the web page. 

Project Name  Ubuntu Linux 
OS Testing 

Version  5.04 Platform  IBM6824 

OS  Ubuntu Component  2.Function －

2.9Application 
Software 
Integration  

Priority  P3  

Reproducibility  Reproducible Submit  yanqw Reviewer caozhy  

Summary  It is unable to print the web page. 

Description  

It is unable to print the web page through the shared printer or the local printer. 

 
Bug Ubuntu0000012 - Volume Control has no help 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  4.Usability  Priority  P3  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  Volume Control has no help  

Description  

1.Launch Application->Sound & Video->Volume Control; 
2.Select menu: Help->contents, there is no help display. 

 
Bug Ubuntu0000027 - Music Player GUI has a localization defect 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  4.Usability  Priority  P5  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  Music Player GUI has a localization defect 

Description  

In the Chinese version of Application->Sound & Video->Music Player, the menu item 
Control->Previous is translated incorrectly.  
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Bug Ubuntu0000031 - There are two "copy" menu item in gThumb Image Viewer 

Project Name Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS Linux  Component  4.Usability Priority P4  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  There are two "copy" menu item in gThumb Image Viewer 

Description  

1.Launch Applications->Graphics->gThumb Image Viewer; 
2.There are two "copy" submenu item in "edit" menu. 

 
Bug Ubuntu0000033 - GnomeMeeting Configuration wizard doesn't show any prompt when 
personal  
information filled in isn't correct in format 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  4.Usability  Priority  P4  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  GnomeMeeting Configuration wizard doesn't show any prompt when 
personal information filled in isn't correct in format 

Description  

1.Launch Application->internet->GnomeMetting; 
2.Select menu: Edit->configuration druid; 
3.Go forward to page 2,enter personal information; 
4.Special format is needed for text area. Otherwise the button "forward" wouldn't be enabled. 
However, the system doesn't show any prompt when personal information filled in isn't correct 
in format. 
 
Bug Ubuntu0000039 - There is text error in PostScript viewer 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  4.Usability  Priority  P4  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  There is text error in PostScript viewer 

Description  

1.Launch Application->internet->PostScript Viewer; 
2.Select "go" menu, the "last page" menu item is translated incorrectly. 
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Bug Ubuntu0000051 - Suggest that some other useful function is added into Evolution Mail 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  4.Usability  Priority  P5  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  Suggest that some other useful function is added into Evolution Mail 

Description  

Add "mail and data export","prevent sender"and "returning receipt" function. 

 
Bug Ubuntu0000041 - Before executing deletion operation, the system does not give the 
confirmation to the process. 
Project Name  Ubuntu Linux OS 

Testing  
Version   5.04 Platform   Dell 600  

OS  Ubuntu  Component   4.Usability Priority   P4  

Reproducibility   Reproducible   Submit   heqq Reviewer   caozhy 

Summary  Before executing deletion operation, the system does not give the 
confirmation to the process. 

Description   

Before executing deletion operation, the system does not give the confirmation to the process. 
For example: Directly deleting the printer which selects, the system has not inquired whether the 
user does confirm the deletion. 
 
Bug Ubuntu0000007 - Sticky key alert window is not shown on top. 

Project Name  Ubuntu Linux OS 
Testing  

Version   5.04 Platform   Dell 600 

OS  Ubuntu  Component   4. Usability Priority   P4  

Reproducibility   Reproducible   Submit   heqq  Reviewer   caozhy 

Summary  Sticky key alert window is not shown on top. 

Description   

1.Systerm->Preference->Keyboard->Accessibility..->Enable keyboard accessibility 
features->Enable Sticky Keys->Disable if tow keys pressed together. 
2.Open a new window. Simultaneously press down "Ctrl" + "Alt". The sticky key alert window 
is not shown on top. It is shown in the taskbar. It is not distinct. 
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Bug Ubuntu0000040 - The GUI of mail accounts editor in Evolution Mail  

isn't localized completely. 

Project Name  Ubuntu Linux 
OS Testing  

Version  5.04 Platform  HP-D330  

OS  Linux  Component  8.Chinese 
Characteristic  

Priority  P4  

Reproducibility  Reproducible  Submit  louli  Reviewer  caozhy  

Summary  The GUI of mail accounts editor in Evolution Mail isn't localized 
completely.  

Description  

1.Launch Application->internet->Evolution Mail; 
2.Select menu: edit->preferences; 
3.Choose a existing account in window, click "edit"; 
4.Choose "Receiving Email" sheet in accounts editor, confirm that server type isn't "None"; 
5.The sheet "Receiving Options" isn't localized completely. 

 
Bug Ubuntu0000056 - Don't support GB18030 

Project  Ubuntu Linux OS 
Testing 

Version  5.04 Platform  IBM 
9CC 

OS  Ubuntu Component  8.Chinese 
Characteristic 

Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Don't support GB18030 

Description  

1.Login; 
2.Open one text file coded by GB18030; 
3.It's Content can't be display correctly. 

 
Bug Ubuntu0000057 - Don't support certain GB13000.1 coding 

Project  Ubuntu Linux OS 
Testing 

Version  5.04 Platform  IBM 
9CC 

OS  Ubuntu Component  8.Chinese 
Characteristic 

Priority  P3  

Reproducibility Reproducible Submit  qinxie Reviewer caozhy  

Summary  Don't support certain GB13000.1 coding 

Description  

1.Login; 
2.Open one text file coded by GB13000.1 with open office; 
3.Certain words can't be displayed correctly. 
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Bug Ubuntu0000058 - The system has not been completely translated into Chinese 

Project  Ubuntu Linux OS 
Testing 

Version  5.04 Platform  HP EVO 
D321 

OS  Ubuntu Component  8.Chinese 
Characteristic 

Priority  P4 

Reproducibility Reproducible Submit  jianggw Reviewer caozhy  

Summary  The system has not been completely translated into Chinese 

Description  

The system interface have not been completely translated into Chinese, such as menu, dialog,
window. 
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